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Main Screen

The main screen for WellVision is shown in Figure 1 and is the default look of the program when first run. Buttons and menus provide access to all features of the program. In general, the buttons provide access to the logging operations while the menus allow adjustment of program setup and advanced features.
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Figure 1

Title bar

The title bar in Figure 2, contains much information about the installation of WellVision and the current logging setup. This is useful when troubleshooting setup information with technical support.The information contained is in the following format.
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Figure 2

Version--Project--Well--Sonde--Winch—System

Version is the version of WellVision
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Project is the active project that all data will be recorded to

Well is the active well that in the active project that data will be recorded to.

Sonde is the currently selected sonde.

Winch is the currently selected winch.

System is the acquisition sub system currently selected.

Main console

This part of the screen in Figure 3, shows the operation conditions of the logging system.

[image: image10.jpg]T Besp sswell s fssh

Time to Surface
H M s
laN aN | aN

Timeto TD
H M s

laN aN | aN

User warning depth

IFissh atDepth
o

I Flssh st Speed
o

TO/Surface warning distance
Distance[5 [+

TD Drillers depth (m): 0





Figure 3

Depth is the current depth reported from the acquisition hardware.

Speed is the computed speed of the winch movement. The arrow next to this field indicates the direction of movement.

Voltage is the applied voltage to the wire line, NOT at the tool.

Current is the current draw of the wire line.

The green/red indicator represents communication status between the computer and the acquisition surface unit. If it is blinking green consistently, and displays a System OK message, computer and surface units are communicating correctly. If this indicator is red and displays a No System message, then the computer cannot detect the surface unit. Please refer to trouble shooting to resolve this problem.

Logging monitor

The logging monitor in Figure 4 is an optional display that is on by default. It duplicates much of the information contained in the Title bar and Main Console. The format is just larger to allow better readability in field conditions. It also displays the current logging mode, Down, Up or Time.
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Figure 4

Pressing the alarms button dispplays the alarm page in Figure 5 to setup the two alarms available when logging.

The TD/Surface alarm is set by default to trigger at 5 meters to the surface (0m) or TD (drillers depth) of the well. When triggered, the alarm flashes the depth display on the logging monitor. Selecting the “Beep as well as flaash” option causes the system alarm sound to bee played.
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Figure 5

User Warning Depth and Speed
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The user can set a custom warning depth and speed for the alarm to trigger. The depth indicator flashes when the user depth has been reached. The Speed indicator flashes when the user speed has been exceeded.

Logging Times

Also on this screen is the estimated Time to Surface and Time to TD based on current speed and depth information. Note that the accuracy of the estimate depends on correct information supplied via the Well Editor.

Status Monitor

By default the Status Monitor in Figure 6 is open at the bottom right of the screen. It contains information about what commands have been sent to the acquisition system, among other information. This is useful for troubleshooting and operator feedback.
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Figure 6

Menus and Buttons

File Menu

The file menu in Figure 7 provides access to project management and quitting WellVision

Quickstart

Opens the quick start dialog which provides a simple logging screen similar to the DOS based ALOG program.
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Make Well Active...

Allows the operator to select a Well from the current project and make it the currrent well.
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Figure 7

New Project ...

Opens the Project Editor dialog allows the creation of a new project.

Open Project ...

Opens a file browser dialog to alllow the selection of an existing project on disk.

Recent Projects

Shows a list of projects previoussly opened for quick access. Selecting a project frrom this list makes it the active project.

Project Information ...

Selecting this menu allows the operator to alter the current project information.

Quit WellVision

Quits WellVision. Stops logging cleanly if currently logging.

Acquire Menu

The acquire menu in Figure 8 is only active when a valid licence and dongle have been used. The entire menu is disabled otherwisse.

Start

Starts the acquisition process.

Stop

Stops the acquisition

Set depth

Opens the set depth dialog. The depth can be set as long as the acquisition system is connected and working.
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Figure 8

Tool setup>Tool Selection

Allows the selection of a tool forr logging

Tool setup>Tool Calibration

Provides access to the tool calibration dialog.

[image: image24.jpg]I (ouckstart ] | [Cvinches ) | [sondes J | [cotioerconval] | [Starttonong ] | [(sioptossns | | [somoptens





Figure 9

Winch & Cable> Winch Selection...

Shows the Winch browser dialogg for winch selection
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Figure 10

Caliper Control

If the current tool has a calibre arm, this menu is enabled allowing power control of the arm

Detect System

Opens the Acquisition settings dialog. The hardware ports and other settings can be access via this menu. Use this menu to connectt to a system if there is a No System message in the main console.

Power Off sonde

If the power to the tool was left on, it may be turned off from this menu.

View Menu

Changing the windows and vieww of data is done via the view menu shown in Figure 11. Some tools add extra views and corresponding entries in to this menu.
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Figure 11

Logging Monitor

Shows/Hides the logging monitoors. A tick indicates that the Logging Monitor is open.

Status Log

Shows/Hides the Status monitor. A tick indicates that the Status Log is open.

Dock Monitors

Positions the Main Window on the left edge of screen and the Logging Monitor and Status monitors to the right side of the screen.

Strip Display

This is the main display used for most tools when acquiring.

Options Menu

Configuration of Wellvision is doone through the Options>Program Options... Mennu in Figure 12.
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Figure 12

Help Menu
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Figure 13

Main buttons

Many of the features controllabble from the menus are available for quick access via the buttons at the top of the main window in Figure 14. When logging, only the Stop Logging and Strip Options are available.
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Figure 14

Quick start

Launches the quick start window

Winches

Presents the Winch Browser for selection of a winch

Sondes

Presents the Sondes Browser for selection of a tool

Caliper control

Presents the calliper control dialog for opening and closing calliper arms if the selected tool has an arm present. Otherwise this button is disabled.

Start Logging

Starts the logging sequence by showing the logging sequence window

Stop Logging

Displays the logging sequence window to stop the current acquisition.
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Setup and Loggging Configuration

All persistent settings used in WellVision are accessible from the Program Options menu. The Options dialog shown in Figure 15 consists of six tabs of information.

Acquisition Settinggs

The acquisition settings tab co ntains information about what system and logging parameters are used in data recording. Most seettings in Figure 15 are defaults by can be overrridden in the logging sequence.
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Figure 15

Leave sonde on after run

Selecting this allows power to the sonde to remain on after a logging run is coomplete. This can be manually overridden at the end of the logging sequence.

Log Mode

Logging can be performed eitherr by depth or time.

Direction

In depth mode logging, the direction of logging is important as data will only be recorded one way.

Press the direction arrow to togggle between the up and down directions.

Depth interval

In depth mode logging, this speccifies the rate at which data is to be recorded. This field is in cm.

Time Interval

In time based logging, this speciffies the rate at which data is to be recorded. Thiss field is in ms.

[image: image37.jpg]



13

[image: image38.jpg]Project Details: Help Demo Project

Project Tite:

Fie Location

Felp Demo Project

D:\WelVISION Projects ielp Demo Project.wproj

Auslog

Ausiralin Logging Services

ALogger

To apply templates to the project, please select Add
Templtes. Templates

orovide convient and consistent oresentation of wel olots.

[Juse project header

[Cuse project templates.

dd Templates

Header layout





WellVision Manual

Strip Display

The defaults used for presenting data in acquisition mode are specified here. Filter width specifies the size of the filtered display daata (if not present in a template). Plot with is the thickness of the plot lines. Plot range is the amount of data visible on screen in either meters or seconds. Visible plots is the number of traces visible at one time on the screen.

Acquisition system

There are multiple systems usedd to acquire data from specialized tools. Most toools only use the DLS4 system. Use the drop down list here to select the system to use for a particular tool.

Setting..

The options for an acquisition syystem can be manipulated using the settings button. The settings are particular to the system but usually contain settings for PC to surface unit communications.

Connect at launch

If a DLS or appropriate system is connected when WellVision launches, it makes an attempt to communicate with it automaticaally.

Print Defaults

The default options for printing can be altered from the tab in Figure 16. Thesse can be overridden from the Print dialog when printting.
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Figure 16

Default Header Layout

This is the path to the header layyout to loaded by default when printing.
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Default Printer

This is the printer that will be selected by default for printing. Change the default by selecting a printer from the drop down list and press “Set now”

Centre print on page

Centres the data printout. This does not affect data, however it is more aesthetically pleasing.

Always print even number of pages

This aids in the folding of fan fold paper when performing multiple prints.

Scales at end of traces

Prints the scales at end of the traces plots as well as the start.

Use project templates if available

If a project has a specialized template for the tool, it will be used for printing/replaying instead of the inbuilt template.

Use project header if available

If a project has a specialized header, it is used instead of the default header file.

Copies

The number of copies to print.

Launching

The settings available in Figure 17 allow the customisation of what displays are opened during automatically after launch.

Last project used

Indicates the last project used in a previous session of WellVision.

Dock monitors

Automatically load all monitors and positions them on the right side of the screen. If this is checked the other check boxes are disabled.

Logging monitor

This will open the Logging Monitor directly after launching WellVision.

Status Monitor

This will open the Status Monitor directly after launching WellVision.
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Figure 17

Sondes

This tab provides access to the Tool Browser in management mode. The Current tool selected is displayed. Press the Manage toools button to manage and select a new tool.
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Figure 18

Winches

Similar to the sondes tab, this taab provides access to the Winch Browser in mannagement mode. The Current tool selected is displayeed. Press the Manage Winches button to managges and select a new winch.
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Figure 19

Licensing

WellVision requires a license file and attached dongle to provide the acquisition functionality (enable the Acquire menu).

The only setting on this tab is the path to the licence file to use. This path is nor mally to a licence file found on your hardware dongle.
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Figure 20
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Data storage and Project Management

Files in WellVision are stored in a folder hierarchy to limit the need of manual file naming and locating somewhere to store the files. Never manually edit any files in this hierarchy, as it may upset the data relationships between the contained files.

Project

The project is the top level directory of the data hierarchy. All Wells and Runs are stored under this directory. The individual files in this directory contain project information and other setup details.

Creating a new project is performed by using the File->new project menu. The Project Editor shown in Figure 21 allows the entry of the project information
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Figure 21
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Project title is the name of the project. This will be the name of the project folder on disk. File location is the location on disk where the project is to be stored. Press the browser button to open the folder to use and then press “Use current folder for project location”.

The Client, Contractor and Operators are all required fields. Changing the value of any of these brings up another dialog to add more detailed information. Only the first field is required though.

Location and Field are the corresponding physical/topological location and field of the project. These values are used when creating a well, so it strongly suggested that they have correct values, as it simplifies creating a new well later on.

After the project is created it becomes the active project. Wells and runs created are always placed in the active project.
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Winch Browser

The Winch Browser operates in two modes: selection and management. Selection mode is accessible from the usual Winches button, the Acquire Menu or from the logging sequence. Management mode is only accessible from the Program Options menu.

Winch Browser provides a list of winches currently configured for use WellVision as shown in Figure 22.
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Figure 22

Each winch contains critical information regarding logging operation. The three most important pieces of information are the cable length, conductors and resistance values of the winch cable.

These values must be correct for best operation of equipment, and are explained bellow:

Winch model: Model of the winch

Winch Serial: Serial number of the winch

Conductors: Specified how many conductors the winch cable has

Length: Total length of cable on winch.

Resistance: Ohms per meter of cable resistance

Inductance: Henries per meter of cable inductance

Capacitance: Farads per meter of cable capacitance
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The length and number of conductors in the winch are very important should be filled out correctly in order for tools to operate correctly.

Winches entries can be created by pressing the "+" button, and removed using the "-" button.

Selecting and pressing the "edit" button allows editing selected winch entry.

Editing and creation of a winch entry is done via Winch Entry editor. Press "Ok" to make changes.
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Tool Browser

Selection and management of the tools used for logging is done via the Tool Browser. Its features are restricted to the context in which it is used; either selection or management. The main sections of the tool browser are the main tool table, picture and bottom table as shown in Figure 23.
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Figure 23

The main table to the left shows the currently available tools for selection. Selecting a tool updates the picture and Channel summary table.

The right side of the Tool Browser shows a graphic outline of the current tool selected as an extra guide to tool selection.

The Channel Summary table shows what channels are available for the tool and their offsets and calibration units.

Selection Mode

Selection mode is accessed via normal tool selection. The Sondes button on the main screen and tool selection from the Acquire menu and the logging sequence allows the normal selection mode. In this
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mode a sonde may be selected for use in logging. The Import ,Export and - buttons shown in Figure 23 are not available in this mode.

Management mode

Management mode is only accessible from the Program Options menu. This mode allows tool files to be imported, exported and removed from the tool list.

Importing a tool

Press the import button and select a tool file that has previously been exported. The imported tool will contain all tool information including the layout and calibration information. If the model and serial number combined are unique, the tool will be added to the tool list. Otherwise a message will appear indicating that the tool already exists and cannot be imported.

Exporting a tool

Selecting the desired tool to export and pressing the Export button will prompt for a file location to store the tool. This exported tool will contain the layout and calibration history information currently.

Removing a tool

Select the desired tool and press the "-" button to remove. This cannot be undone so make sure it is the right tool and that you really want to delete it.
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Starting an acquisition

The logging of data is performed via the “Start” logging commands found in the Acquire menu, the Start button on the main screen or via the quick start window. The logging sequence is activated, presenting the user successive screens of options and information.

The first screen of the sequence is shown in Figure 24. This indicates the Project and Well that the data will be recorded in. If the active Well has not been selected then a new one will have to be created. See section “Data Storage and Project Management” regarding options for creating a new Well.
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Figure 24

The Function keys (F1,F6 and F8) can be used as a pseudo compatibility with ALOG navigation.

The following screen in sequence is shown in Figure 25. The active tool/instrument and winch selection can be altered here by pressing the Change... buttons. More on the Tool Selector and Winch Selector is described in section “Winch Browser”.

If a previous run of data was recorded with the selected tool and in the current well, data can be appended to it rather than creating a new run. The “Append to previous” dropdown list displays a list of valid runs to which the data can be appended.
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Figure 25

After tool and winch selection the mode of logging can be selected from on the next screen, as shown in Figure 26.
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Figure 26

Depth mode records data when the tool has moved a corresponding distance in the well. The direction of the movement depends on the Direction selection. When in this mode, data will only be recorded when the movement of the tool is in the right direction. Change the direction of logging by pressing on the Direction arrow. Note that tools with calliper arms only allow logging the up direction. Time mode logging disables the Direction as data is stored by time index instead of depth.

The Sample Interval field specifies the rate of depth or time recording. For higher resolution data, use smaller numbers (eg 1cm for depth mode and 100ms for time mode). Note that the actual value of the depth rate may vary as it is dependent on the depth factor of the selected winch.
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Figure 27 shows the next display in the logging sequence. This screen allows the depth of the logging system to be set. Also the current speed of the winch system is displayed.

To change the depth press the “Set” button, to display the set depth dialog shown in Figure 27.
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Figure 27

This is the screen at which the tool needs to be lowered to its starting position. If you a logging Down, this would be at the top of the well. If you are logging up, the starting position will be at the bottom of the well.

If the tool has a calliper arm attached the screen in Figure 28 will show. This allows the control of the calliper arm. Press the Open button to power the arm in an opening direction. Likewise press Close to power the arm in the closing direction. The graph of current indicates the power draw of the arm motor. When there is a sharp transition on this graph the arm has completed an open or close movement.

To continue the logging sequence, the power applied to the calliper arm, must be turned off, by pressing the “Power Off” button.
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Figure 28

At this stage in the logging sequence logging is ready to commence. Normally pressing the OK button will initialize the data storage and communications with the tool.
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Figure 29

In the case where advanced power and communications settings may need to be used please see section #.

After initialization, the display in Figure 30 will show, indicating to start the winch. It will remain until the Ok button is pressed or until the winch starts to move
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Figure 30

Use Next >> and << Back to navigate through the start logging process. Select Cancel to cancel the process. Once all the steps have been completed select the Strip Plot Display will launch and you will be prompted to start your winch. The logging steps are listed below. Please ensure that you have created or selected a project before you start logging.
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Calibration

Tool files contain calibration infoormation for applicable channels for a particular tool. As the tool file contains a serial number matching only one tool, calibrations are not directly transferable to other tools. The entire calibration histtory of the tool is remembered in the tool files to allow traceability and comparison.

All calibration operation are performed from the acquire menu and require a valid license and dongle are used for access.

The calibration dialog shown in Figure 31 is accessed via Aquire->Tool setup->Tool calibration.
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Figure 31

Calibration Selection

The lower left of the window shoows the options you can perform for you calibrattion.

New calibration

Adds a new entry in the calibrattion history. The current calibration is copied to the new entry

Edit current calibration

The current calibration informaation is modified but does not record the data in a new calibration entry.

Load Previous Calibration

Loads a previous calibration enttry and create a new entry with its data.
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Pressing Start Calibration activates the calibration, and allows new values to bee added as shown in Figure 32.
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Figure 32

There are typically more than one channel per sonde to calibrate. The active chhannel to calibrate is selected from the Channel Namme in the top right of the screen. You can switcch between channels during the calibration process to add points to other channels.

Data Tab

The Data tab shows the data enttered/acquired for the calibration and allows neww points to be added or removed. Data is presented in the table showing the jig value and the reading that was measured at that jig value. Use the – button to remove and entry or the Clear all button to clear all data from the table.

Adjust the Jig Units under the table to represent the units to which you are calibrating.

Adding Calibration Points

There are multiple methods of adding calibration points, from a range of source data. Note that the data points are sorted in ascendding order with respect to Jig value. Points added may not appear at the end of the table, but rather in the ordered position.

Also jig values in the data table must be unique. Adding another calibration point with an existing jig value with not add the point by override the existing calibration point.
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The first is acquiring data from a connected sonde and acquisition system. Addd the Jig Value and acquisition parameters in Figure 33 to acquire data from the selected channel. If the Tool has a caliper arm attached you can coontrol it by pressing the caliper control button at the bottom of the screen. Press Acquire point to read data from the attached hardware.
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Figure 33

Sample rate

The time in seconds between samples.

Delay

Time in seconds before the reading commences

Sample count

The number of samples to recoord. The average of these samples is used as the actual measured point.

The second method of adding points allows adding known jig value and measurrement pairs without acquiring directly from the sonde.

Jig value

The value calibrated unit

The second method of adding a calibration point is manually adding known readings and CPS values
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in Figure 34 and pressing Add.

Figure 34

The third method of importing points is from a CSV file in Figure 35. It is simmilar to the previous method of data import, but allowws a bulk amount of data to be added.


Figure 35
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Extracting Calibration Points

Data can also be exported from to a CSV file for external storage and reference . Press the Export to CSV Buton in Figure 32 and select a file name to save the data from the currently selected channel.

Calibration Mappiing Tab

Calibration points added in the first Tab can be viewed graphically in the Calibraation Mapping tab as shown in Figure 36. This tab also allows the type of mapping to be applied and other mapping options.


Figure 36

The graph in Figure 36 shows the Data point and the mapping Mapping applied to generate the calibrated data. This particular example shows the “Lookup” mapping mode.

Mappings

The type of mapping of the dataa depends on the calibration relation ship of the calibrated units and the particular attributes of the tool channel being calibrated. There are two modes of Mapping available. In both modes of mapping, linear extrapolation is uses to continue the mapping beyond the extreme data points.

Linear

This a performs a linear fit over all the data points from the Data tab to generat a gradient and offset to calibrate raw values. In this mode the ignore offset checkbox can be applied to remove the effect of the calculated offset (making it 0).
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Lookup

In this mode the the points represent exact points on the calibration mappings and linear interpolation is used to calculateed values that lay between adjacent points.

Prescale function

The prescale function performs a operation to the raw cps dat before it is used in the calibration mapping. This is useful to lineariize non linear cps responce curves for certain toool channels.

Applying the calibrration

After the data points are added and the mapping mode is selected, pressing D one will present the Report Tab in Figure 37. The repport can be saved to a file for later use or for trracebility by pressing the Save Report button.


Figure 37

Pressing the OK button here applies the calibration to the tool file and will be used for furture data acquisitions from this tool.

Pressing the Cancel button canccels the entire operation and no modification to the calibration are recorded.
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Reviewing and Processing

After a run is recorded it can be replayed from the Process menu. Here either the current well or another well can be reviewed. All data is accessable from the Well Browser, shown in Figure 38.


Figure 38

This shows a summary of the Well selected on the left on the Well Summary. Details such as the well Name, location and drilling information can be modified for the well by pressing the Edit/Updat... button. The Well Editor in a similar fashion to creating a well.

Figure 39 shows the Runs tab of the well Editor. Selecting a run from the Runs list shows a summary of the channel information in the table on the bottom of the screen. This shows how many records are present, start and end depths as well as direction and logging mode.
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Figure 39

After selecting a run, the processing of the run can be selected via the large button son the right of the window. Exporting of data to the LAS format is accessed via the Export button. Printing with out viewing the traces is accessed directed via the Print button. Review of the data on screen is accessd via the Replay/Preview button.

Exporting

Pressing the Export button in the Well Browser shows the Run exporter in Figure 50. Channels available in the run are listed int he Channels table. By default only the channels shown on a printout will be selected for export. Likewise the filting value applied to the data will be extraced from the run template.

To alter the settings for a channel to export, select the channel and Check/Uncheck the Export checkbox and modify the filter value under the filter column.

The range of the data to export can be modified by altering the From and To fields. The Min and Max field indicate the actual range of the data stored in the run.
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Figure 40

Currently the only exporter supported is LAS. To adjust settings for the LAS generation, press the Settings button to access the dialog in Figure 40.


Figure 41

Version 2 is the suggested format and is selected by default. The Null value and sample rate can be specified as well via Figure 41.
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Once all export settings are selected, press the Export button to select a file name and generate the LAS file.

Printing Data

Pressing the Print button in Figure 39 will print the selected run using the settings contained within the run and the default print settings specified via the Program Options. These settings can all be changed via the Print dialog shown in Figure 42.


Figure 42

Header presentation

The header printed can be adjusted by pressing the Headers button. The Header Layout dialog shown in Figure 43 allows what types of information and in which order information is displayed on the header printout.
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There are three section for header data. The header information can be added and removed from each section by using the + and – buttons. Pressng the + button presents the Header selectorin Figure 44, from which a header can be selected.

Header layouts can be loaded and saved to disk for future use using the Load and Save butons.


Figure 43

Job Header

This is the main header for th print job. It should contain most of the hole informaiton as it is printed before the data traces for the run are printed.

Range Header

This is the header to be used between well ranges (if used). By default it is a blank space to sperate the ranges.

Job Footer

At the end of the print job this header is printed. By default this contains channel information such as offsets and calibration information.
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Figure 44

Also the header can be specified to be located on a seperate page to the rest of the print if the “Header on seperate page” is selected on the Print dialog

Range selection

The most common options to change are the in the Range selection. The layout of the data and the amount of data is controlled with these options.

Print Well Ranges

If there are ranges defened for the Well, these can be applied to the print out. This is automatically selecteed if there are Well ranges defined. Well ranges specify a Start and End depth for a print. The defined Well ranges can be edited by pressing te Define Ranges... button.

If not printing with Well Ranges, the start and end depth of the print can be directly specifed using the Fomr and To fields. Under each of these fields is the maximum and minimum values recorded for the run.

Template Selection

By defaul the template stored in the run is used in the print. Selecting another template file will apply the layout settings from the specified template instead.

Other options

Print scale at endof range

Prints the scales of the channels and the bottom of the print as well as the start.
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Centre on page

Centres the print out on the page for a nicer look.

Print even page count

Prints a even number of pages so that fanfold type pager folds easier.

Print Setup

Pressing the Priter setup button in Figure 42 displays the standard Page setup dialog in Figure 45.

Please refer to your computer manaul for further information about the standard Page setup dialog.


Figure 45

Print

Pressing the Print button in Figure 42 displays the standard Print dialog in Figure 46. The number of copies along with printer selection can be performed here. For more information please refer to your computer manual.
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Figure 46

Replay/Preview

This section of WellVision allows the operator to view previously recorded data and adjust the templates used for presentation. An example of the Replay/Preview window is shown in Figure 47. The Replay/Preview windows is accessed by pressing the Replay/Preview button in Figure 39.
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Figure 47

The entire contents of the hole is viewable by scrolling the bar on the right of the window. The depth at the top of the display is shown in the Depth/Time field at the bottom of the window.

The view can be zoomed by adjusting the zoom percentage. This allows for more data to be viewed in both down and across the page. Altering the scale field adjusts the scaling in the vertical directions. It is a ratio of a meter of screen/page to well depth (m) or time (s).

The channels displayed on screen are those currently listed in the template that match those that are in the tool run. If channels are visible on the replay screen , double clicking on the scale header will present the settings for that channel, as shown in Figure 48.
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Figure 48

This screen allows fine control over the colours and lines and filtering. Also the position of the trace on the printout is can be specified via the Strip location. Stip width defines the width of the strip in cm.

Double clicking on the scale header displays a similar dialog in Figure 49. These settings perform similar function for the scale channel.
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Figure 49
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